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Input File Format  
 

Tab-delimited Text Files with Variable Names 
 
Tab-delimited text files are comprised of data separated (i.e., delimited) with a character tab.   Tab-
delimited text files used for data analysis typically have variable names in the first row of the file.  The 
simplest way to generate a tab-delimited text file is by specifying “tab-delimited text” as a file save option 
in Microsoft Excel.  The example below shows the setup necessary for saving data and variables names to 
a tab-delimited text file in Excel. 
 

    
 
To save the data listed above, select File, then Save As, then select Tab delimited (txt), as in: 
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Next, in the Save As window, specify the file name as “protein_data”: 
 

 
 
 
You will notice two popup windows, the first of which states that multiple sheets cannot be saved in the 
file, so click OK: 
 
 

 
 
 
And the second which states that you can lose special features of Excel when saving data into a tab-
delimited text file.   For example, bold fonts and colors cannot be saved with the data, thus, click Yes: 
 

 
 
 
Next, open the “protein_data.txt” file just saved, and the following will appear: 
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Tab-delimited Text Files with Variable and Record Names 
 
The following illustrates a file setup with both variable and record names.   For this example, the variable 
names are the sample (patient) identifiers and the record names in the last column are the genes or 
proteins.   This setup is commonly used for DNA microarray data, however, BioMedStat was designed for 
clinical statistical analysis for clinical data in which records represent patients and columns represent 
variables or measurements made on the experimental units (patients).  (If you want to analyze 
microarray data, then use the ChipST2C program).   The example is shown below: 
 

 
 
To continue, after the data above were saved as a tab-delimited text file and opened, the following format 
will be observed: 
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Example 1 - Opening a Tab-Delimited Text File  

When BioMedStat is installed, the icon is placed on the Desktop with a shortcut link to the BioMedStat 
program.   The desktop shortcut appearance is as follows: 
 

 
 
(Note that in some cases, BioMedStat may be installed without a desktop shortcut requiring program 
startup by on the Start, then Programs, then BioMedStat.) 
 
To start BioMedStat, double-click on the desktop icon.   You will then see a splash screen: 
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Next click on the Start button, and the BioMedStat application will then be visible, as shown below: 
 

 
 
 
To open a file, select File, Open, Text data, as shown below 
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and the Input format popup window will appear:  

 
 
Since tab-delimited is the default text file format it won’t need to be specified, however, check the 
“Variable names in first row” option and click OK.   In the Open popup window, you should see the text 
files that were installed in the c:\Program Files\BioMedStat\BioMedStat\ directory, as shown below:  
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Select the Hosmer & Lemeshow low birth weight file, and then click on Open (or double-click the 
filename).  When the file is read into BioMedStat, the status text filed and progressbar on the log tab will 
indicate the amount of data read and copied into the data viewing spreadsheet.  When completed, the 
data viewing tab will show the data that were read in.  (Note: the spreadsheet in the Data tab is only 
used for viewing data and not editing, i.e., changing, copying, pasting, etc.) 
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Example 2 – Summary statistics of several variables 
 
Data used for this example were published in the book Hosmer, D.W. and Lemeshow, S. Applied Logistic 
Regression, New York, Wiley (1989) and are available form the University of Massachussetts (Amherst) 
Statistical Software Information Internet resources at URL http://people.umass.edu/statdata/statdata/.   
These data are copyrighted by John Wiley & Sons Inc. and must be acknowledged and used accordingly. 
Data were collected at Baystate Medical Center, Springfield, Massachusetts during 1986.    
 
The data set is comprised of 189 observations for 11 variables (risk factors) associated with giving birth to 
a low birth weight baby (weighing less than 2500 grams).  Data were collected on 189 women, 59 of 
which had low birth weight babies and 130 of which had normal birth weight babies.  Four variables which 
were thought to be of importance were age, weight of the subject at her last menstrual period, race, and 
the number of physician visits during the first trimester of pregnancy. 
 

Columns Variable Abbreviation
   

2-4 Identification Code ID 
   

10 Low Birth Weight (0 = Birth Weight >= 2500g, LOW 
 1 = Birth Weight < 2500g)  
   

17-18 Age of the Mother in Years AGE 
   

23-25 Weight in Pounds at the Last Menstrual Period LWT 



 

10 
 

   
32 Race (1 = White, 2 = Black, 3 = Other) RACE 

   
40 Smoking Status During Pregnancy (1 = Yes, 0 = No) SMOKE 

   
48 History of Premature Labor (0 = None  1 = One, etc.) PTL 

   
55 History of Hypertension (1 = Yes, 0 = No) HT 

   
61 Presence of Uterine Irritability (1 = Yes, 0 = No) UI 

   
67 Number of Physician Visits During the First Trimester FTV 

 (0 = None, 1 = One, 2 = Two, etc.)  
   

73-76 Birth Weight in Grams BWT 
 
 
Background information for the data: 
         

 Low birth weight is an outcome that has been of concern to physicians for years.  
 Infant mortality rates and birth defect rates are very high for low birth weight babies  
 A woman's behavior during pregnancy (including diet, smoking habits, and receiving prenatal care) 

can greatly alter the chances of carrying the baby to term and, consequently, of delivering a baby 
of normal birth weight 

         
The risk factors described above have been shown to be associated with low birth weight in the obstetrical 
literature. The goal of the Hosmer & Lemeshow study was to ascertain if these variables were important in 
the population being served by the medical center where the data were collected. 
 
 
 
 
Open the tab-delimited text file for the Hosmer & Lemeshow low birth weight data (see Example 1).   
Select the Summary statistics command of the Analyze pull-down menu, shown as 
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Notice that the Variables tab opens, shown as follows: 
 

 
 
Select all but the first variable (ID number) in the following manner: 
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Then click on the  button to add the variables to the list of selected variables: 
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and finally, click on the  button.  The Treeview on the left will show a number of icons in the form: 
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To view the summary statistics for each variable, click on the  icon, and the text output containing 
summary statistics for the specified variables will become visible: 
 

 
 

To observe the frequency histogram of age, click on the  icon and the following histogram will appear: 
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Example 3 – Recode a continuous variable into quartiles, 
and then recode into 4 new indicator variables  
 
Open the Hosmer & Lemeshow low birth weight data (see Example 1), select the Variables tab and then 
select (highlight) the “age” variable as: 
 

 
 
Next, at the bottom of the Variables tab are several buttons for transforming the values of variables into 
new values: 
 

 
 

Now that the “age” variable is selected in the variable list, click on the  button, and a 
new (ordinally ranked) categorical variable called “age_(quartiles)” will be generated and shown in the 
variable list.  At run-time, the cutpoints for quartiles are computed (to see their values, run the summary 
statistics option on the age variable) and the resulting values for the new variable are 1, 2, 3, 4, 
representing the age quartile that each record (patients) is assigned to.   Select the new variable 
(“age_(quartiles)”) in the fashion 
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and then click on the  button.  Upon completion of the transformation, there will be 
four new indicator or “dummy” variables added to the list, appearing as: 
 

 
 
The four indicator variables have values of 0 or 1 depending on whether or not a patient’s age falls within 
the given quartile represented by the variable.  If you run summary statistics on the age_(quartiles) 
variable, the following histogram will be generated: 
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which clearly shows that the variable takes on values of 1, 2, 3, or 4 at various frequencies of occurrence.  
 
 

Example 4 – Parametric 2-sample paired T-test  
 
Let us consider the example listed on page 77 of Siegel (Siegel, S.,  Non-parametric Statistics for the 
Behavioral Sciences, New York, McGraw-Hill, 1956) involving matched data on social perceptiveness 
scores from identical twin pairs.   The hypothesized experiment for this example tests whether or not 
there is a difference between social perceptiveness scores between twins after one of the twins attends a 
single term of nursery school and the other stays home.   The data are listed below: 
 
 

 
 

Identical 
twin 
pair 

Social 
perceptiveness 
score of twin 

in nursery 
school 

Social 
perceptiveness 
score of twin 

at home 
a 82 63 
b 69 42 
c 73 74 
d 43 37 
e 58 51 
f 56 43 
g 76 80 
h 65 82 
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Let’s use a “paired T-test” to determine if the average social perceptiveness scores are the same between 
the twin pairs.   Start BioMedStat, and first specify the Open command of the File pull-down menu, then 
Text, and then specify variable names in first row as shown below: 
 

 
 
 
 
Next, select the file Siegel_table_5_6.txt, shown as: 
 

 
 
 
and you will see the data in the viewing spreadsheet as follows: 
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To begin the analysis, select the “T-tests (paired samples)” command of the 2-sample command of the 
Analyze pull-down menu as follows:     
 

 
 
 
Specify the nursery variable as Variable 1, and home variable as Variable 2 (shown below) and then click 
on Run.   
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And the resulting icons and table (after clicking “nursery” icon) will appear as: 
 

 
 
 
The test statistic of 1.2789 for a two-tailed test is compared with a tabled critical value of t0.05; 7=2.365, so 
the decision rule is to accept the null hypothesis that there is no difference between the average social 
perceptiveness score among matched pairs of twins.   The relevant mathematical formulae are given as: 
 
 

T-Test (Paired Samples) 

 nursery home 

Sample Size (n_1, n_2): 8 8 

Average [avg(x), avg(y)]: 65.2500 59.0000 

Variance [var(x), var(y)]: 157.6429 329.1429 

Numerator: avg(d_i) 6.2500 d

s.d.(d_i) 13.8229 d
s

Denominator 4.8871 / 13.8229/ 8
d
ns =  
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Test Statistic* 1.2789
4.8871

/ 1.2789
d

d

ns
=  

d.f. 7 0.05,7 2.365t =  

P-value 0.2456  

Mean permutation t -0.02  

Permutation p-value 0.2423  

Iterations 9999  
*Daniel, W.W.  Paired Comparisons (Sect. 6.4).  In: Biostatistics:  A Foundation 
for Analysis in the Health Sciences (5th Edition).   New York, Wiley (1991). 

 
 
 
While the SPSS (12) benchmark results are as follows: 
 
 
 Paired Samples Statistics 
 

  Mean N Std. Deviation 
Std. Error 

Mean 
Pair 1 nursery 65.250 8 12.5556 4.4391

home 59.000 8 18.1423 6.4143

 
 Paired Samples Test 
 

  Paired Differences     

  Mean Std. Deviation 
Std. Error 

Mean 
95% Confidence Interval 

of the Difference       

        Lower Upper t df Sig. (2-tailed) 
Pair 1 nursery - 

home 
6.2500 13.8229 4.8871 -5.3062 17.8062 1.279 7 .242

 
 
 
 
 

Example 5 – Non-parametric 2-sample paired Wilcoxon 
signed rank test  
 
This example will also use an aggressiveness score among 12 sets of identical twins, given on page 283 of 
Conover, W.J. The Wilcoxon Signed Rank Test. In: Practical Non-Parametric Statistics (2nd Edition). New 
York, Wiley (1980).   Start BioMedStat, and first specify the Open command of the File pull-down menu, 
then Text, and then specify variable names in first row as shown below: 
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Next, select the file “conover_page_283_Wilcoxon.txt, shown as: 
 

 
 
 
 
and you will see the data in the viewing spreadsheet as follows: 
 



 

23 
 

 
 
 
 
 
 
To begin the analysis, select the “Wilcoxon signed ranks test” command of the 2-sample command of the 
Analyze pull-down menu as follows:     
 

 
 
 
Specify the second variable as Variable 1, and first variable as Variable 2 (shown below) and then click on 
Run. 
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And the resulting icons and table (after clicking “Wilcoxon” icon) will appear as: 
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The test statistic of -0.76 for a two-tailed test is compared with a tabled critical value of -1.96, so the 
decision rule is to accept the null hypothesis that the two distributions are alike.   The relevant 
mathematical formulae are given as: 
 
 
 
 

Wilcoxon Signed Rank Test  

 Second vs. first  

Sample Size 12 n 

Sum(R_i) -17.00 
1

n

i
i

R

  

Sqrt[Sum(R_i^2)] 505.00 2

1

n

i
i

R

  

Z-score* -0.76 2

1 1

n n

i i
i i

R R
 
   

P-value 0.4899  

P-value(Permutation) 0.1190  

Avg. perm. Z -0.5135  

Iterations 1000  

*Conover, W.J. The Wilcoxon Signed Rank Test. In: Practical 
Non-Parametric Statistics (2nd Edition). New York, Wiley (1980) 

 
 
The SPSS (12) benchmarked results for the Wilcoxon test are: 
 
 
 Ranks 
 

    N Mean Rank Sum of Ranks 
first - second Negative Ranks 4(a) 6.13 24.50

Positive Ranks 7(b) 5.93 41.50
Ties 1(c)   
Total 12   

a  first < second 
b  first > second 
c  first = second 
 
 
 Test Statistics(b) 
 

  first - second 
Z -.756(a) 
Asymp. Sig. (2-tailed) .449 

a  Based on negative ranks. 
b  Wilcoxon Signed Ranks Test 
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Example 6 – Parametric independent 2-sample t-test  
 
This example uses the Hosmer and Lemeshow low birth weight data described in detail in Example 2. 
To begin, select File, Open, Text data, as shown below: 
 

 
 
 
and the Input format popup window will appear:  

 
 
check the “Variable names in first row” option and click OK.   Open the Hosmer and Lemeshow low birth 
weight data file as shown below: 
 



 

27 
 

 
 
 
In the Analyze pull-down menu select 2-sample tests, then T-tests (independent samples) shown as: 
 
 

 
 
 
Recall that in the low birth weight data set, the variable “low” takes on a value of 0 when birth weight >= 
2500g, and 1 when birth weight < 2500g.   Using “low” as the grouping variable for the two groups, 
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let’s test if there is a significant age difference between women giving birth to a normal weight baby 
(low=0) or low weight baby (low=1).  Next, select “age” as the continuous variable, and “low” as the 
categorical variable, shown as: 
 
 

 
 
 

Then, click Run and click on the icon and you will observe the following tables containing results: 
 

T-Test (Independent samples) 

Test var:  Age Equal variances assumed 

Grouping var:  Low  

 1 2 

Sample Size (n_1, n_2): 130 59

Average [avg(x), avg(y)]: 23.6615 22.3051

Variance [var(x), var(y)]: 31.1869 20.3536

Equal variance test: F-ratio: 0.2916(1,187) Prob: 0.4102
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Pooled common variance 27.8268
2 2

2 1 1 2 2

1 2

( 1) ( 1)

2p

n s n s
s

n n

- + -
=

+ -
 

Denominator 0.8281
2
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ps n n

+  

Test Statistic 1.6381
1 2

2

1 2

1 1
p

X X

s
n n

-

+
 

d.f. 187 1 2 2n n+ -  

P-value 0.1072  

Mean permutation t 0.00  

Permutation p-value 0.1028  

Iterations 9999  

   

 
T-Test (Independent samples) 

Test var:  age Unequal variances assumed 

Grouping var:  low  

 1 2 

Sample Size (n_1, n_2): 130 59

Average [avg(x), avg(y)]: 23.6615 22.3051

Variance [var(x), var(y)]: 31.1869 20.3536

Numerator: avg(x)-avg(y) 1.3565 1 2X X-  

Denominator 0.7648
2 2
1 2

1 2

s s

n n
+  

Test Statistic 1.7737
1 2

2 2
1 2

1 2

X X

s s

n n

-

+

 

d.f. (Dixon & Massey correction) 137

22 2
1 2

1 2
2 2 2 2
1 1 2 2

1 2

'
( / ) ( / )

s s

n n
df

s n s n

n n

æ ö÷ç ÷+ç ÷ç ÷çè ø
=

+
 

P-value 0.0809  

Mean permutation t 0.04  
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Permutation p-value 0.0766  

Iterations 9999  

*Daniel, W.W.  The t Distribution (Sect. 5.6).  In: Biostatistics:  A Foundation  
for Analysis in the Health Sciences.   New York, Wiley (1974).

 
 
The first table contains results for Levene’s variance ratio test for equal variances, as well as the t-test 
results assuming equal variances.   The equal variance test has a resulting p-value of 0.42, so we accept 
the null hypothesis that the variances are equal.   The test statistic for the t-test (assuming equal 
variances) is 1.638, for which the p-value is 0.11, so for these data there is not a significant difference in 
age between mothers giving birth to low and normal weight babies.   
 
The SPSS(12) benchmarked results are:   
 
 Group Statistics 
 

  low N Mean 
Std. 

Deviation 
Std. Error 

Mean 
age 0 130 23.662 5.5845 .4898

1 59 22.305 4.5115 .5873
 
 
 Independent Samples Test 
 

    

Levene's Test for 
Equality of Variances t-test for Equality of Means 

F Sig. t df Sig. (2-tailed) 
Mean 

Difference 
Std. Error 
Difference 

95% Confide
of the D

Lower 
age Equal 

variances 
assumed 

3.429 .066 1.638 187 .103 1.3565 .8281 -.2771

Equal 
variances 
not 
assumed 

   1.774 136.941 .078 1.3565 .7648 -.1558

 
 
 
 
 
 

Example 7 – Non-parametric independent 2-sample Mann-
Whitney U Test  
 
This example uses the Hosmer and Lemeshow low birth weight data described in detail in Example 2. 
To begin, select File, Open, Text data, as shown below: 
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and the Input format popup window will appear:  

 
 
check the “Variable names in first row” option and click OK.   Open the Hosmer and Lemeshow low birth 
weight data file as shown below: 
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In the Analyze pull-down menu select 2-sample tests, then T-tests (independent samples) shown as: 
 

 
 
 
 
Next, select “age” as the continuous variable, and “low” as the categorical variable, shown as: 
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Then, click Run and click on the icon and you will observe the following tables containing results: 
 
 

Mann-Whitney Test 

Test var:  age  

Grouping var:  low  

 1 2 

Sample Size 130 59 

R 12753.00 5202.00 

U1,U2 3432.00 4238.00 

U based on Min(U1,U2) 3432.00  

Mean U 3835.00  

s.d.(U) 348.48  

Z-score -1.16  

P-value 0.3014  

P-value(Permutation) 0.2467  



 

34 
 

Avg. perm. Z -0.7980  

Iterations 9999  

 
 
Benchmark results from SPSS(12) are: 
 
 
 Ranks 
 

  low N Mean Rank 
Sum of 
Ranks 

age 0 130 98.10 12753.00
1 59 88.17 5202.00
Total 189    

 
 Test Statistics(a) 
 

  age 
Mann-Whitney U 3432.000 
Wilcoxon W 5202.000 
Z -1.159 
Asymp. Sig. (2-
tailed) 

.247 

a  Grouping Variable: low 
 
 
 

Example 8 – Parametric independent k-sample Analysis of 
Variance 
 
This example focuses on a one-way analysis of variance (ANOVA) to determine statistically significant 
differences between age among three racial groups in the Hosmer and Lemeshow low birth weight data 
described in Example 2.   In the low birth weight study, the categorical variable “race” was coded to 
represent 1-white, 2-black, and 3-other.   In the following procedures, we will use BioMedStat to test for a 
significant difference in age among the three groups using an independent k-sample F-test as part of the 
ANOVA.  
 
To start, open the Hosmer and Lemeshow data set as described in Example 2.   Under the “k-sample” 
command of the Analyze pull-down menu specify “F-test (independent samples),”  shown as follows:     
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Select age as the continuous variable and race as the categorical variable, and then click on Run. 
 

 



 

36 
 

 
 
The results of the ANOVA re shown as follows: 
 

Analysis of Variance 

Test var: age 

Grouping var: race 

Group: Sample size Mean s.d. 

1 96 24.292 5.655 

2 26 21.538 5.109 

3 67 22.388 4.536 

    

ANOVA Table SS MSE F(v_1,v_2) 

Treatment 230.08 115.04 4.24 (2, 186) 

Error 5048.21 27.14  

P-value 0.0158   

P-value(Permutation) 0.0810   

Avg. perm. F-ratio 2.0286   

Iterations 1000   
 
 
 
SPSS(ANOVA) results for the same ANOVA are: 
 
 Descriptives 
 
age  

  N Mean 
Std. 

Deviation Std. Error

95% Confidence Interval for 
Mean 

Minimum MaximumLower Bound Upper Bound 
1 96 24.292 5.6548 .5771 23.146 25.437 14 45
2 26 21.538 5.1087 1.0019 19.475 23.602 15 35
3 67 22.388 4.5359 .5541 21.282 23.494 14 33
Total 189 23.238 5.2987 .3854 22.478 23.998 14 45

 
 ANOVA 
 
age  

  
Sum of 
Squares df 

Mean 
Square F Sig. 

Between 
Groups 

230.080 2 115.040 4.239 .016

Within Groups 5048.205 186 27.141   
Total 5278.286 188    
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Example 9 – Non-parametric independent k-sample 
Kruskal-Wallis Test  
 
Open the Hosmer and Lemeshow data (see Example 2), and specify a Kruskal-Wallis test: 
 

 
 
 
 
Next, specify age as the continuous variable and race as the categorical variable as 
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And then click on Run.   The results of the Kruskal-Wallis test are shown below: 
 

Kruskal-Wallis Test 

Test var: age 

Grouping var: race 

Group: Sample size, n(j) Sum of ranks, R(j) Average rank, R(j)/n(j)

1 96 10055.50 104.74

2 26 1968.00 75.69

3 67 5931.50 88.53

Chi-square (d.f.) 7.22 (2)   

P-value 0.0270   

P-value(Permutation) 0.0190   

Avg. perm. Chi-square 1.9026   

Iterations 1000   
 
Benchmark results for SPSS(12) are: 
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 Ranks 
 

  race N Mean Rank 
age 1 96 104.74 

2 26 75.69 
3 67 88.53 
Total 189   

 
 Test Statistics(a,b) 
 

  age 
Chi-Square 7.251 
df 2 
Asymp. 
Sig. 

.027 

a  Kruskal Wallis Test 
b  Grouping Variable: race 
 
 
 
 

Example 10 – Pearson product moment and Spearman rank 
correlation 
 
Using the Hosmer and Lemeshow data again, below are the BioMedStat results for correlation analysis. 
 
 

Pearson 
Correlation 

Matrix 

 

 low age lwt race smoke ptl ht Ui ftv 

age -0.12         

lwt -0.17* 0.18*        

race 0.14 -0.17* -0.17*       

smoke 0.16* -0.04 -0.04 -0.34**      

ptl 0.20** 0.07 -0.14 0.01 0.19**     

ht 0.15* -0.02 0.24** 0.02 0.01 -0.02    

ui 0.17* -0.08 -0.15* 0.05 0.06 0.23** -0.11   

ftv -0.06 0.22** 0.14 -0.10 -0.03 -0.04 -0.07 -0.06  

bwt -0.79** 0.09 0.19** -0.20** -0.19** -0.15* -0.15* -0.28** 0.06 
 
Significant, negative: 
** p < 0.01 
* p < 0.05 
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Significant, positive: 
** p < 0.01 
* p < 0.05 
 
 

 
 
 
SPSS(12) benchmarking results for Pearson correlation are: 
 Correlations 
 

    low age lwt race smoke ptl ht ui 
low Pearson 

Correlation 
1 -.119 -.170(*) .138 .161(*) .196(**) .152(*) .169(*)

Sig. (2-tailed)   .103 .020 .059 .027 .007 .036 .020
N 189 189 189 189 189 189 189 189

age Pearson 
Correlation 

-.119 1 .180(*) -.173(*) -.044 .072 -.016 -.075

Sig. (2-tailed) .103  .013 .017 .545 .328 .829 .304
N 189 189 189 189 189 189 189 189

lwt Pearson 
Correlation 

-.170(*) .180(*) 1 -.165(*) -.044 -.140 .236(**) -.153(*)

Sig. (2-tailed) .020 .013  .023 .546 .055 .001 .036
N 189 189 189 189 189 189 189 189

race Pearson 
Correlation 

.138 -.173(*) -.165(*) 1 -.339(**) .008 .020 .054
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Sig. (2-tailed) .059 .017 .023  .000 .914 .785 .464
N 189 189 189 189 189 189 189 189

smoke Pearson 
Correlation 

.161(*) -.044 -.044 -.339(**) 1 .188(**) .013 .062

Sig. (2-tailed) .027 .545 .546 .000   .010 .855 .395
N 189 189 189 189 189 189 189 189

ptl Pearson 
Correlation 

.196(**) .072 -.140 .008 .188(**) 1 -.015 .228(**)

Sig. (2-tailed) .007 .328 .055 .914 .010  .833 .002
N 189 189 189 189 189 189 189 189

ht Pearson 
Correlation 

.152(*) -.016 .236(**) .020 .013 -.015 1 -.109

Sig. (2-tailed) .036 .829 .001 .785 .855 .833  .137
N 189 189 189 189 189 189 189 189

ui Pearson 
Correlation 

.169(*) -.075 -.153(*) .054 .062 .228(**) -.109 1

Sig. (2-tailed) .020 .304 .036 .464 .395 .002 .137  
N 189 189 189 189 189 189 189 189

ftv Pearson 
Correlation 

-.063 .215(**) .141 -.098 -.028 -.044 -.072 -.060

Sig. (2-tailed) .389 .003 .054 .178 .702 .544 .322 .416
N 189 189 189 189 189 189 189 189

bwt Pearson 
Correlation 

-.785(**) .090 .186(*) -.196(**) -.189(**) -.155(*) -.146(*) -.283(**)

Sig. (2-tailed) .000 .219 .010 .007 .009 .034 .045 .000
N 189 189 189 189 189 189 189 189

*  Correlation is significant at the 0.05 level (2-tailed). 
**  Correlation is significant at the 0.01 level (2-tailed). 
 

 
 

The Spearman rank correlation results from BioMedStat are: 
 

Spearman Correlation 
Matrix 

 

 low age Lwt race smoke ptl ht ui ftv 

age -0.08         

lwt -0.18* 0.19**        

race 0.14* -0.15* -0.19**       

smoke 0.16* -0.05 -0.09 -0.34**      

ptl 0.26** 0.12 -0.11 0.04 0.19**     

ht 0.15* -0.01 0.17* 0.02 0.01 0.00    

ui 0.17* -0.08 -0.18* 0.05 0.06 0.19** -0.11   

ftv -0.09 0.23** 0.09 -0.15* -0.08 -0.01 -0.08 -0.06  

bwt -0.80** 0.06 0.25** -0.18* -0.20** -0.20** -0.11 -0.27** 0.07 
 
Significant, negative: 
** p < 0.01 
* p < 0.05 
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Significant, positive: 
** p < 0.01 
* p < 0.05 
 

 
 
 
 
while the SPSS(12) benchmarking results for Spearman rank correlation are: 
 
 Correlations 
 

 Spearman   low age lwt race smoke ptl ht ui 
low Correlation 

Coefficient 
1.000 -.085 -.182(*) .142 .161(*) .261(**) .152(*) .169(*)

  Sig. (2-tailed) . .248 .012 .051 .027 .000 .036 .020
  N 189 189 189 189 189 189 189 189
age Correlation 

Coefficient 
-.085 1.000 .186(*) -.152(*) -.048 .119 -.005 -.075

  Sig. (2-tailed) .248 . .010 .037 .515 .104 .944 .302
  N 189 189 189 189 189 189 189 189
lwt Correlation 

Coefficient 
-.182(*) .186(*) 1.000 -.189(**) -.085 -.111 .170(*) -.175(*)

  Sig. (2-tailed) .012 .010 . .009 .243 .129 .019 .016
  N 189 189 189 189 189 189 189 189
race Correlation .142 -.152(*) -.189(**) 1.000 -.338(**) .036 .024 .051
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Coefficient 

  Sig. (2-tailed) .051 .037 .009 . .000 .623 .742 .482
  N 189 189 189 189 189 189 189 189
smoke Correlation 

Coefficient 
.161(*) -.048 -.085 -.338(**) 1.000 .187(**) .013 .062

  Sig. (2-tailed) .027 .515 .243 .000 . .010 .855 .395
  N 189 189 189 189 189 189 189 189
ptl Correlation 

Coefficient 
.261(**) .119 -.111 .036 .187(**) 1.000 .002 .194(**)

  Sig. (2-tailed) .000 .104 .129 .623 .010 . .980 .008
  N 189 189 189 189 189 189 189 189
ht Correlation 

Coefficient 
.152(*) -.005 .170(*) .024 .013 .002 1.000 -.109

  Sig. (2-tailed) .036 .944 .019 .742 .855 .980 . .137
  N 189 189 189 189 189 189 189 189
ui Correlation 

Coefficient 
.169(*) -.075 -.175(*) .051 .062 .194(**) -.109 1.000

  Sig. (2-tailed) .020 .302 .016 .482 .395 .008 .137 .
  N 189 189 189 189 189 189 189 189
ftv Correlation 

Coefficient 
-.086 .234(**) .089 -.155(*) -.083 -.014 -.080 -.056

  Sig. (2-tailed) .239 .001 .223 .034 .254 .845 .275 .442
  N 189 189 189 189 189 189 189 189
bwt Correlation 

Coefficient 
-.803(**) .061 .248(**) -.184(*) -.196(**) -.204(**) -.115 -.266(**)

  Sig. (2-tailed) .000 .404 .001 .011 .007 .005 .117 .000
  N 189 189 189 189 189 189 189 189

*  Correlation is significant at the 0.05 level (2-tailed). 
**  Correlation is significant at the 0.01 level (2-tailed). 
 
 
 

Example 11 – Covariance analysis 
 
Using the Hosmer and Lemeshow data again, below are the BioMedStat results for covariance analysis. 
 

Color Scale
-

265.99 
-

67.47 
-

26.04 
-

2.41 
-

1.66 
-

0.66 
-

0.15 
-

0.11 
-

0.03
-

0.02
-

0.02 0.00 0.00 0.01 0.02 0.04 0.04 0.06 1.21 4.55 44.99 4141.80

 

Covariance 
Matrix 

 

 low age lwt race smoke ptl ht ui ftv 

age -0.29         

lwt -2.41 29.18        

race 0.06 -0.84 -4.63       

smoke 0.04 -0.11 -0.66 -0.15      

ptl 0.04 0.19 -2.11 0.00 0.05     
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ht 0.02 -0.02 1.77 0.00 0.00 0.00    

ui 0.03 -0.14 -1.66 0.02 0.01 0.04 -0.01   

ftv -0.03 1.21 4.55 -0.10 -0.01 -0.02 -0.02 -0.02  

bwt -265.99 347.14 4141.80 -131.36 -67.47 -55.65 -26.04 -73.61 44.99 
 
 
The SPSS(12) covariance matrix is shown below: 
 
 
 Inter-Item Covariance Matrix 
 

  low age lwt race smoke ptl ht ui ftv bwt 
low .216 -.293 -2.410 .059 .037 .045 .017 .028 -.031 -265.993
age -.293 28.076 29.177 -.841 -.115 .187 -.021 -.142 1.209 347.141
lwt -2.410 29.177 935.099 -4.635 -.661 -2.112 1.767 -1.664 4.552 4141.798
race .059 -.841 -4.635 .843 -.152 .004 .004 .018 -.096 -131.356
smoke .037 -.115 -.661 -.152 .240 .045 .002 .011 -.015 -67.471
ptl .045 .187 -2.112 .004 .045 .243 -.002 .040 -.023 -55.650
ht .017 -.021 1.767 .004 .002 -.002 .060 -.009 -.019 -26.037
ui .028 -.142 -1.664 .018 .011 .040 -.009 .127 -.022 -73.608
ftv -.031 1.209 4.552 -.096 -.015 -.023 -.019 -.022 1.122 44.992
bwt 

-265.993 347.141 4141.798 -131.356 -67.471 -55.650 -26.037 -73.608 44.992
531473.68

4
The covariance matrix is calculated and used in the analysis. 
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Example 12 – Chi-square 2-way contingency table analysis 
  
Open the Hosmer and Lemeshow data again (Example 2).  Specify a 2-way contingency table analysis.    
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Next select race and smoke as the categorical variables, and click on Run: 
 

 
 
 
The result of the run is as follows: 
 
 

Chi-Square test 

 

  Smoke 

  1 2 Total 
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race 1 44 52 96 

 2 16 10 26 

 3 55 12 67 

 Total 115 74 189 

 Chi-square (d.f.) 21.78(2)   

 Tabled chi-square(0.95) 6.4516   

 P-value 0.0000   

 Iterations 1000   

 Mult. prob (observed) 8.97795524039906E-06   

 Randomization P-value 0.0000   
 
 
SPSS(12) results are as follows: 
 
 race * smoke Crosstabulation 
 
Count  

  
smoke 

Total 0 1 
race 1 44 52 96

2 16 10 26
3 55 12 67

Total 115 74 189
 
 Chi-Square Tests 
 

  Value df 

Asymp. 
Sig. (2-
sided) 

Pearson Chi-
Square 

21.779(
a) 2 .000

Likelihood Ratio 22.997 2 .000
Linear-by-Linear 
Association 21.609 1 .000

N of Valid Cases 189    

a  0 cells (.0%) have expected count less than 5. The minimum expected count is 10.18. 
 
 
 
 
 
 

Example 13 – Linear regression 
  
Open the Hosmer and Lemeshow data again (Example 2).  Specify a linear regression as shown below: 
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Next, specify low as the dependent variable and all other variables except for race as the independent 
variables (shown below), and click on Run: 
 

 
 
 
The result of the run is as follows: 
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Linear Regression 
Dependent variable: low 

Regression Coefficients

Variable Coef. s.e. Wald Prob. Score 

Const 1.9292 0.1647 137.2897 0.0000 0.0000

age -0.0050 0.0042 1.4596 0.2144 0.0000

lwt -0.0003 0.0007 0.1946 0.6591 0.0000

smoke -0.0027 0.0443 0.0038 0.9508 0.0000

ptl 0.0897 0.0451 3.9572 0.0461 0.0000

ht 0.0685 0.0917 0.5587 0.4548 0.0000

ui -0.1002 0.0637 2.4790 0.1125 0.0000

ftv 0.0000 0.0205 0.0000 0.9993 0.0000

bwt -0.0005 0.0000 244.4939 0.0000 0.0000

 
 
The SPSS(12) result of the run are as follows: 
 
 Coefficients(a) 
 

Model   
Unstandardized 

Coefficients 
Standardized 
Coefficients t Sig. 

    B Std. Error Beta     
1 (Constant) 1.927 .149  12.948 .000
  age -.005 .004 -.057 -1.208 .229
  lwt .000 .001 -.022 -.441 .660
  smoke -.003 .044 -.003 -.062 .951
  ptl .090 .045 .095 1.989 .048
  ht .069 .092 .036 .747 .456
  ui -.100 .064 -.077 -1.574 .117
  ftv -1.779E-05 .021 .000 -.001 .999
  bwt .000 .000 -.778 -15.636 .000

a  Dependent Variable: low 
 
 
 

Example 13 – Logistic regression (unconditional) 
 
Open the Hosmer and Lemeshow data (Example 2), and specify Regression Unconditional logistic.    
Highlight the race variable as shown below: 
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Next, click on the “Expand into dichotomous indicator variables” button as shown below: 
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Now add low as he “case” variable and age, lwt, race_(2), race(3), and ftv as independent variables, as 

shown below: 
 

 
 
Click on Run.   The results are shown below: 
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Unconditional Logistic Regression 
Dependent variable: low 

Regression Coefficients

Variable Coef. s.e. Wald Prob. Score 

Const 1.2954 1.0714 1.4617 0.2141 0.0000

age -0.0238 0.0337 0.4988 0.4800 0.0000

lwt -0.0142 0.0065 4.7430 0.0292 0.0000

race_(2) 1.0039 0.4979 4.0660 0.0433 0.0000

race_(3) 0.4331 0.3622 1.4296 0.2186 0.0000

ftv -0.0493 0.1672 0.0869 0.7681 0.0000

 
 
 

Odds Ratios
Variable OR Lower 95% CI Upper 95% CI 

Const 3.652331566 0.447238627 29.826417184

age 0.976458553 0.913992390 1.043193923

lwt 0.985856363 0.973298538 0.998576214

race_(2) 2.728897888 1.028492574 7.240580891

race_(3) 1.542043413 0.758143585 3.136474321

ftv 0.951887601 0.685849579 1.321120596

 
 
 

Contrasts 

 

Const age lwt race_(2) race_(3) ftv RR Lower 
95% CI 

Upper 
95% CI 

Chi-
square Prob 

 +  +     0.96 0.90 1.03 0.00 1.0000 

 +   +    2.66 1.00 7.13 4.06 0.1312 

 +    +   1.51 0.45 5.08 1.43 0.4897 

 +     +  0.93 0.26 3.27 0.00 1.0000 

  +  +    2.69 1.02 7.13 4.07 0.1309 

  +   +   1.52 0.46 5.08 1.43 0.4894 

  +    +  0.94 0.27 3.27 0.00 1.0000 

   +  +   4.21 1.15 15.36 4.41 0.1102 

   +   +  2.60 0.68 9.87 4.07 0.1309 
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    +  +  1.47 0.66 3.25 1.40 0.4958 

 +  +  +    2.63 0.74 9.31 4.06 0.2660 

 +  +   +   1.48 0.35 6.34 1.43 0.6991 

 +  +    +  0.92 0.21 4.06 0.00 1.0000 

 +   +  +   4.11 0.57 29.65 4.21 0.2492 

 +   +   +  2.54 0.34 18.78 4.06 0.2660 

 +    +  +  1.43 0.17 12.37 1.40 0.7052 

  +  +  +   4.15 0.33 52.30 4.41 0.2285 

  +  +   +  2.56 0.20 32.96 4.07 0.2655 

  +   +  +  1.45 0.10 21.03 1.40 0.7048 

   +  +  +  4.01 0.20 81.46 4.41 0.2290 
 
SPSS(12) results are: 
 
 
 Variables in the Equation 
 

  B S.E. Wald df Sig. Exp(B) 
Step 
1(a) 

age 
-.024 .034 .499 1 .480 .976 

  lwt -.014 .007 4.743 1 .029 .986 
  race     4.411 2 .110   
  race(1) 1.004 .498 4.066 1 .044 2.729 
  race(2) .433 .362 1.430 1 .232 1.542 
  ftv -.049 .167 .087 1 .768 .952 
  Constant 1.295 1.071 1.462 1 .227 3.652 

a  Variable(s) entered on step 1: age, lwt, race, ftv. 
 
The same regression coefficients and standard errors are listed in Table 2.2 on page 30 of Hosmer and 
Lemeshow, Applied Logistic Regression, New York, Wiley, 1989. 


